
Presentation Plus! The American Republic Since 1877 1

The American Republic
Since 1877



Presentation Plus! The American Republic Since 1877 2

Presentation Plus! was designed and developed by FSCreations, Inc., Cincinnati, Ohio  45202.

Apple, Macintosh, Mac, and QuickTime are trademarks of Apple Computer, Inc. in the United States and other 
countries. Microsoft and PowerPoint are registered trademarks of Microsoft Corporation. All other trademarks 
are the property of their respective owners.

Copyright © by The McGraw-Hill Companies. All rights reserved. Permission is granted to reproduce material 
contained herein on the condition that such materials be reproduced only for classroom use; and be provided 
to students, teachers, and families without charge. All other reproduction, for use or sale, is prohibited without 
prior written permission of the publisher.

Send all inquiries to:

GLENCOE DIVISION
McGraw-Hill
8787 Orion Place
Columbus, OH 43240

Glencoe Software Support Hotline:
1-800-437-3715, 8:00 am–6:00 EST or customers with specific questions can contact 
us at: epgtech@mcgraw-hill.com Customers can also access our support Web site for 
basic information and answers to the most frequently asked questions: 
http://www.epgtech.com
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To the Teacher
Glencoe’s Presentation Plus! is an exciting multimedia 
teacher tool that enables you to present dynamic lessons 
for every unit and chapter of The American Republic 
Since 1877 text.  Many of the teaching resources you 
have come to rely on—including full-color transparencies, 
Vocabulary PuzzleMaker, Interactive Tutor Self-
Assessment, and more—are now at your fingertips in this 
easy-to-use product.  Using Presentation Plus! and a Web 
browser, you also get instant access to online activities and 
resources at the tarvol2.glencoe.com Web site.

NOTE: The Presentation Plus! system is based on 
Microsoft PowerPoint. To use the full version of the 
software, you must have PowerPoint 2001 or later for 
the Macintosh. You do not need the PowerPoint software 
to use the lite version of the software, however, since 
a Viewer program is included with the slide shows. If 
you do have access to PowerPoint 2001, you can also 
customize your presentations.

Site License Agreement: By installing this software, you accept the terms and 
conditions of the McGraw-Hill Companies End User Software License Agreement. 
A copy of this agreement can be found on our Web site at www.epgtech.com, or 
on the CD-ROM under the filename LICENSE.TXT. This can also be attained by 
contacting our Software Support Hotline at 1-800-537-3715.
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Features of Presentation Plus!
Each slide show includes the following features:

 – View an extensive 
collection of regional and special-purpose 
maps.

 – Connect to a presentation 
that showcases all of the United States 
Presidents.

 – Connect to The 
American Republic Since 1877 Web 
site for additional activities and teaching 
suggestions.

 – Access current state 
profi les as needed in your instruction.

Unit Slide Shows
In addition to the features above, the unit slide 
shows may include the following features:

 – Take a look at relevant 
literature selections and how they pertain 
to American History.

 – All Cause and Effect 
transparencies are included in Presentation 
Plus!

 – Delve into the link 
between geography and history.

 – Step back with Time 
Notebook and see what people’s lives were 
like in the time periods being studied.

Chapter Slide Shows
Chapter slide shows may also include the 
following features:

 – Increase your students’ 
knowledge of technology with these 
activities.

 – Give your students the 
opportunity to increase their understanding 
of social studies.

 – Guide your students 
through activities to improve their critical 
thinking skills.

 – Work through these 
activities to help your students excel at 
studying and writing.
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 – All Why it Matters 
transparencies are included in Presentation 
Plus!

 – Incorporate Glencoe’s 
PuzzlePlayer software into your lesson 
plans.

 – All Daily Focus Skills 
transparencies are included in Presentation 
Plus!

 – Examine the causes and 
effects of important events in history.

 – Add information to your 
lessons to build relevance and add interest.

 – Did historic events really 
happen the way you think they did? Utilize 
this feature to help your students fi nd out.

 – Connect lessons in history 
to other academic disciplines.

 – Hear about an interesting 
moment in history from National 
Geographic.

 – Use Glencoe’s Interactive 
Tutor Self-Assessment software to quiz 
your students.

 – Integrate the You Don’t 
Say feature into your lesson.

 – Connect lessons in history 
with technology of that time period.

 – Integrate The American 
Republic Since 1877 videos where they 
are relevant throughout Presentation Plus! 

Presentation Plus! Lite
The Presentation Plus! Lite software is a 
scaled-down version of Presentation Plus! 
designed to run with PowerPoint 98 or 
with the PowerPoint Viewer. Presentation 
Plus! Lite includes the lecture notes and 
chapter assessment questions from each 
chapter of the full product, but it does not 
include the audio, video, features, maps, 
charts, or unit presentations.
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Running Presentation Plus!
Setting Up your Equipment 

Before you begin using the Presentation 
Plus! system, check your equipment 
connections. To use the Presentation 
Plus!, you will need a computer (see 
System Requirements on page 8) and a 
projector or large-screen monitor.

Presentation Plus! (full version) 
Start-Up Instructions (PowerPoint 2001)

1. Make sure that your monitor is set to 
thousands of colors at 800 x 600 or 
higher resolution. If your screen is not 
set properly, click the Apple menu, 
Control Panels, Monitors and change 
the monitor settings.

2. Start the PowerPoint 2001 software. 
Follow the instructions that came 
with the program. The full version of 
Presentation Plus! is not compatible 
with PowerPoint 98 or the PowerPoint 
Viewer.

3. Choose to open a presentation.

4. Select your CD-ROM drive.

5. Select the PowerPoint 2001 folder.

6. Choose a presentation (e.g., TAR2 Unit 
06, TAR2 Chapter 20).

7. Select View Show from the Slide Show 
menu to begin the presentation.

8. When you start a presentation, you 

will see an opening slide. Click the 
Forward button to proceed to the next 
slide.

9. From the Contents (or Main menu) 
slide you can access many of the 
Presentation Plus! resources. While 
viewing a presentation, click the 
navigation buttons to view the slides. 
Click the Help button for step-by-step 
instructions.

10. To end the presentation, click the Exit 
button or press the Esc (escape) key.

Presentation Plus! (lite version) 
Start-Up Instructions (PowerPoint 98)

1. Make sure that your monitor is set to 
thousands of colors at 800 x 600 or 
higher resolution. If your screen is not 
set properly, click the Apple menu, 
Control Panels, Monitors and change 
the monitor settings.

2. Start the PowerPoint 98 software. 
Follow the instructions that came with 
the program. 

3. Choose to open a presentation.

4. Select your CD-ROM drive.

5. Select the PowerPoint 98/Viewer 
folder.

6. Choose a presentation 
(e.g., TAR2 Chapter 20).

7. Select View Show from the Slide Show 
menu to begin the presentation.
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8. When you start a presentation, you 
will see an opening slide. Click the 
Forward button to proceed to the next 
slide.

9. To end the presentation, click the Exit 
button or press the Esc (escape) key.

Presentation Plus! (lite version) 
Start-Up Instructions (PowerPoint Viewer)

1. Make sure that your monitor is set to 
thousands of colors at 800 x 600 or 
higher resolution. If your screen is not 
set properly, click the Apple menu, 
Control Panels, Monitors and change 
the monitor settings.

2. Install the Viewer if it is not already 
installed. To do this, simply copy the 
Microsoft PowerPoint 98 Viewer 
folder from the PowerPoint 98/Viewer 
folder on your CD-ROM to the hard 
drive of your computer.

3. Start the Viewer software. To do 
this, double-click on the Microsoft 
PowerPoint 98 Viewer icon on your 
hard drive. 

4. Select the PowerPoint 98/Viewer 
folder.

5. Choose a presentation 
(e.g., TAR2 Chapter 20).

6. Click the Show button.

7. When you start a presentation, you 
will see an opening slide. Click the 
Forward button to proceed to the next 
slide.

8. To end the presentation, click the Exit 
button or press the Esc (escape) key.

System Requirements
Verify that your computer system meets 
the hardware and software requirements 
listed below. 

• Any PowerPC processor-based, 
Mac OS-compatible system 
(clock speed of at least 120 MHz 
recommended)

• 64MB of RAM with Virtual Memory 
turned on

• CD-ROM drive
• Monitor or display supporting 

thousands of colors, with 800 x 600 or 
higher resolution

• Apple Mac OS System 8.1 or 
later (System 8.5 or later strongly 
recommended)

• Microsoft PowerPoint 98, Viewer, or 
2001

• Internet connection 28.8 or higher 
(optional, but recommended)

• Printer (optional, but recommended)
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Navigating the Software
Using the Presentation Plus! system is 
easy.  Once you select a presentation, 
just use a mouse or another compatible 
pointing device to step through a slide 
show.  As you view a slide show, you can 
use the following buttons/keys to navigate 
a presentation.

Use the Forward button to move 
forward one slide at a time through the 
software.  

Click the Back button to move 
back to the previous slide. 

  Click the Home button to display 
the Contents (or Main menu) slide.

To go to the beginning of a section 
or part, click the Section Start button.  
Depending on where you are working in 
a presentation, click this button to return 
to the slide from which you accessed a 
particular option.  

Click the Exit button or press the 
ESC (escape) key to end a slide show.
  

Use the Speaker button to listen 
to the audio provided in the presentations.

Click the Speaker Off button to 
turn any audio off.

Click the Help button to access 
step-by-step instructions on using 
Presentation Plus!

 Click the Map/Chart button to 
access maps and charts that pertain to the 
Lecture Notes you are viewing.

 Click the Map/Chart/
Photograph button to access maps, 
charts, and photographs that pertain to the 
assessment question you are viewing.

Press the Space Bar to display the next 
item on a slide. If the last item is already 
displayed, the program will display the 
next slide.

Use the Backspace key to move to a 
previous item on a slide.  If no items 
appear on a slide, the program will go to 
the previous slide.

The presentations also include hyperlinks.  
A hyperlink to another slide or to a 
different part of a presentation appears as 
yellow, underlined text.  When you click 
on a hyperlink, the program takes you 
immediately to the location associated 
with the link.  If you accidentally select a 
hyperlink, you can click the appropriate 
navigation button to return to where 
you were.  



Presentation Plus! The American Republic Since 1877 10

Teaching Tips
Presentation Plus! combines many of the 
teaching tools you are already familiar 
with in one complete package.  Listed 
below are a few teaching suggestions that 
may be helpful for presenting Presentation 
Plus!, especially if you have never used a 
PowerPoint presentation before now.

• Check your equipment setup before 
class begins.  Configure your computer 
system and projector so that they work 
properly with each other.  If you have 
a videodisc player, make sure that it is 
working properly too.

• Work through at least one unit and one 
chapter presentation.  Check out all 
of the features.  Once you familiarize 
yourself with the flow and operation 
of one presentation, you will be ready 
to work with all of the others since 
they follow the same organization and 
navigation.

• Preview the presentations before 
using them in the classroom.  Use the 
teaching suggestions in the Teacher 
Wraparound Edition to help you 
develop a plan to integrate the 
presentation into your lesson plan.

• If you have Microsoft PowerPoint 
98 (or a later version), you can print 
the slides to use as handouts or as a 
teaching reference.  Open a presentation 
and choose Print from the File menu.  
Using the Print pop-up menu, you can 
choose to print 2, 3, or 6 slides per 
page.  This will save time and paper 

when printing the slides.  All slides 
have been set up to print in black and 
white so that the text shows.  To print 
only selected slides, click on the Slides 
radio button and then enter the desired 
print range (e.g., 5-12).

• Refer to the Teacher Wraparound 
Edition and the print components 
that accompany the other integrated 
software components for teaching 
suggestions.

 
• Discuss proper note-taking techniques 

with your students.  Explain how to 
record important words, ideas, and 
phrases. The lecture notes that are 
provided as part of Presentation Plus! 
are not designed to be copied word for 
word.

 
• If you have Microsoft PowerPoint 98 

(or a later version), you can customize 
any of the slide presentations to meet 
your classroom needs.  You can edit 
slides, add new ones, and delete 
unneeded slides. See page 11 for more 
information.
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Customizing a Presentation
The Presentation Plus! software was 
created using Microsoft PowerPoint 2001.   
Follow the steps listed below to customize 
a presentation.

IMPORTANT:  If you are not thoroughly 
familiar with PowerPoint, practice creating 
your own presentations.  You could also 
work through a tutorial to learn how to 
use the powerful features available in this 
program.

To customize a presentation:
 
1. Before you make any changes to a 

PowerPoint presentation, you should 
create a folder on your hard drive.

2. Since you cannot make changes to the 
presentations on the CD-ROM, copy 
the presentation(s) to the folder you 
created on your hard drive.  Linked 
presentations will need to be copied 
into the folder as well. 

 If you have enough hard disk space, 
you can copy all of the presentations 
to your hard drive.  Approximately 
650 MB disk drive  is needed.  Each 
presentation includes all of the art, 
audio, and links in its own file.  You 
will still need to have the Presentation 
Plus! CD-ROM in the drive to use the 
Interactive Tutor, Puzzles, and Help 
features.

3. Customize the presentation to meet 
your classroom needs.  Refer to the 
suggestions and tips listed below 

before you make any changes to a 
presentation.

•  If you have deleted any art element 
(e.g., a button or a picture) from 
a presentation, you will need to 
copy the element from another 
presentation or slide within the 
current presentation if you want to 
insert the element back into a slide 
show.  Separate art elements are not 
provided as part of Presentation 
Plus!

•  All of the chapter and unit 
presentations use the custom show 
feature for all features accessed 
through buttons on the left side 
of the slides. You should fully 
understand how custom shows 
function before making any 
modifications to these slides.  If, 
for example, you add a slide to a 
feature, you must also update the 
corresponding custom show list so 
that PowerPoint will know how to 
display the new slide.

•  Changes to the Chapter Introduction, 
Lecture Notes, and Chapter 
Assessment slides can easily be 
made since these slides are not part 
of a custom show.  You can add 
slides, delete slides, and update 
slides as needed.

•  Hyperlinks and action settings 
are used to control the action for 
many of the buttons found in a 
presentation.  Be sure to test the 
navigation carefully if you change 
or add a hyperlink.
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Troubleshooting Tips
Glencoe provides toll-free telephone assistance for teachers who experience difficulty while 
using our software or templates.  Before calling for assistance, please check the following:

• Is your computer working properly?  On the same computer, try some other software that 
you know is working.

•  Can you repeat the problem? 
•  Does the problem occur at the same point each time?
•  Review the list of troubleshooting tips below to see if your problem is identified.

In order for the Support Center to help you as quickly as possible, have the following 
information at hand when you call for assistance:
 
•  exact title and ISBN number of the software from the disk label or package
•  brand, model, and configuration of the computer and printer you are using
•  version of the operating system installed on your computer
            
The Glencoe Support Center toll-free number is 1-800-437-3715.  The Support Center is 
available from 8:00 a.m. to 6:00 p.m. Eastern Time.  You can also contact the Support Center on 
the Internet at the following e-mail address:  epgtech@mcgraw-hill.com

Using the Help System

In addition to the Glencoe Support Center, an extensive Help system is incorporated into 
Presentation Plus!  Whenever you need help, just click the Help button to display step-by-step 
instructions. 

If the appropriate topic does not appear, click on the Contents button to see the table of contents 
for the Help system.  Or, click on the Search button to find a particular topic.

Troubleshooting Tips

The presentation is difficult to read when displayed on a screen. 
The quality of the images projected through PowerPoint depends on several factors.  Make sure 
that you are displaying the image onto a reflective surface—not a blackboard or other similar 
surface.  Using a better screen can greatly improve the display quality.  Darken the room if 
possible.  Check the quality of your projector.  This, too, greatly impacts the display quality.
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The navigation buttons do not seem to work properly.
Click the Exit button or press the Esc (escape) to exit the slide show.  Press the Home key to 
scroll to the first slide in the presentation and then choose Slide Show in the View menu to 
start the presentation at the beginning. If this does not solve the problem, increase the memory 
settings for PowerPoint.  To do this, go to the Finder and click once on the PowerPoint 
application on the hard drive of your computer to highlight it.  Click File, Get Info, Memory 
and increase the Minimum and Preferred memory settings to at least 24000 K.  Also, in the 
Memory Control Panel make sure that Virtual Memory is turned on.

Colors on the slides do not seem correct.
The Presentation Plus! software requires that you set your monitor to thousands of colors or 
better.  If your monitor is set for 256 colors, the quality of the images as they appear on your 
screen may not be very good.  (See the next tip for instructions on how to check or change your 
color settings.)

How do you set the screen resolution and colors?
Depending on your computer system and projector, you may need to set your monitor to 800 
x 600 or higher resolution.  Using these instructions, you can also change the color setting.  
Use the Monitors Control Panel or the Monitor Bit Depth Control on the Control Strip to 
change your setting to thousands of colors.

While viewing a presentation, some portions of the screen are not updated. 
Increase the memory settings for PowerPoint.  To do this, go to the Finder and click once on 
the PowerPoint application on the hard drive of your computer to highlight it.  Click File, Get 
Info, Memory and increase the Minimum and Preferred memory settings to at least 24000 K.  
Also, in the Memory Control Panel make sure that Virtual Memory is turned on. You may 
also decrease your screen resolution to 800 x 600 and your color depth to thousands of colors to 
lower memory requirements. 

The text is not clear on the projected image, but the text is okay on the monitor. 
The resolution for a projector needs to match the resolution for your monitor.  If your monitor 
is set to 800 x 600, for example, text may look squeezed on a projected image.  Refer to your 
projector’s manual for instructions on setting the display resolution.

Audio segments do not play. 
Make sure that your speakers are turned on and that the volume is set properly.  Volume control 
is located in the Sound Control Panel and on the Control Strip.

When the program displays a new slide, the mouse pointer does not immediately appear. 
This is a function of PowerPoint.  After a new slide appears, move the mouse a few times to get 
the pointer to appear.  PowerPoint won’t show the mouse until you move it so that the pointer 
does not interfere with your presentation.



Presentation Plus! The American Republic Since 1877 14

Long delays seem to occur randomly while viewing a presentation.
You may want to turn off the AutoRecover feature.  To do this, choose Preferences from the 
Edit menu, select the Save tab, and turn off the appropriate option. Since the presentations 
are quite large, saving the files may require a few moments.  If you are viewing a presentation 
at that time, the slide show will appear not to respond.  Even though you are viewing a slide, 
Microsoft PowerPoint 2001 will still autosave any open files according to the set parameters.
A delay may also occur when you click on the Connect button.  Clicking on this button 
launches your browser, dials your phone (if necessary), and connects to the Glencoe Web site.  
Depending on the speed of your computer, a few minutes may be required.

PowerPoint has difficulty displaying a presentation stored on a network drive or CD-ROM 
network server. 
There may be noticable delays running from a network. These delays can be caused by 
network speed, network traffic, or the server. See your network administrator if you are having 
difficulties. 

Clicking the Connect button does not launch your Web browser. 
You must have Netscape 4.0 or Explorer 4.0 (or a later version) installed on your computer.  
When you click on the Connect button, a minute or two may be needed for the Web browser 
to launch and connect to the Internet.  If you don’t have enough memory or you experience 
problems with the connection, the Web browser may not start properly.  You can quit the 
Presentation Plus! software and manually launch your Web browser.  Then go to the Web site 
that is specified on the slide.

An error appears when printing slides, or only a portion (e.g., half) of a slide prints. 
If you try to print a slide that includes large art elements, your printer may display a memory 
overflow error or the printer may only print a portion of a slide.  First, make sure that you are 
printing in the black and white mode.  All of the presentations have been optimized so that only 
the most important information prints.  Background art should be turned off.  If you add your 
own slides, this may not be the case.  Choose Grayscale from the View menu.  Then 
control + click on an object and set its grayscale format.  For example, you can choose not to 
show an object in grayscale mode.
Another option to try is to print handouts (2 or 3 handouts per page).  This option may also 
alleviate printing problems.
If you want to print slides with all of the art elements, you may need to add more memory to 
your printer.  See the manual that accompanies your printer for more information.

Solutions are not provided for the crossword puzzles.
If you want to print a solution for a puzzle, start the PuzzleMaker program from your CD-ROM 
drive.  After the program starts, choose to open a puzzle.  Select the puzzle you want and then 
choose to print it.  Exit the program when you are finished.
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A slide show does not work properly after making changes to a presentation.
The Presentation Plus! slide shows contain many hyperlinks and action settings.  Make sure 
that you did not accidentally delete or change any of these.  To check for missing slides, use the 
Slide Sorter view.  In this mode, you can view several slides at one time. 
All of the chapter and unit presentations use the custom show feature for all features accessed 
through buttons on the left side of the slides (unless they are a linked presentation).
You should fully understand how custom shows function before you make any changes to 
these slides.  If, for example, you add a slide to one of these parts, you must also update the 
corresponding custom show list so that PowerPoint will know how to display the new slide.

PowerPoint cannot locate or start the PuzzlePlayer program, Interactive Tutor program, or 
Help program.
The Presentation Plus! CD-ROM must be inserted in the CD-ROM drive for these features to 
function.

Nothing happens when I click on the Puzzles, Interactive Tutor, or Help buttons.
These options will not work if you disable macros. Close and reopen the presentation, and click 
Enable Macros when a message box appears.

I don’t know how to exit the PuzzlePlayer program to return to my PowerPoint presentation.
From the PuzzlePlayer program, click the File menu and Quit.

The Interactive Tutor program won’t work because the disk is write protected.
When registering as a new student, change the Data Path to a folder on your hard drive. 
Another option is to register as a guest.

Presentation Plus! does not seem to be running properly in MacOS X.
Presentation Plus!  will run in Classic Mode within MacOS X using the PowerPoint Viewer 
or PowerPoint 2001 or earlier. If you have PowerPoint v.X or later, the presentations will run 
within MacOS X but Interactive Tutor and PuzzleMaker will launch in Classic Mode. This 
could cause a delay as MacOS 9.2 is loaded within MacOS X.

None of the troubleshooting tips solve the problem.
If you have not customized the presentations, call the Glencoe/McGraw-Hill software support 
number listed at the top of this page.

If you have difficulty customizing a presentation, you may want to access the Microsoft Web 
site at http://www.microsoft.com for assistance with your problem.  At this Web site, you can 
search through their online support database.  Another excellent source for help is the Microsoft 
PowerPoint discussion group at microsoft.public.powerpoint.mac
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